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ABSTRACT 
 
Many scholars, professionals, and students have begun to employ geospatial analysis in their research; however, the 
teaching of geospatial thinking, especially beyond the discipline of geography, is still in its formative stages. 
Geospatial thinking, a synthesis of spatial concepts, methods, technologies, and applications, is an essential and 
integral part of the social sciences. Studies show that today’s students require teaching strategies dedicated to 
experiential learning that facilitate knowledge acquisition by making use of their unique development skills, heavily 
grounded in visualization and spatial perception. This paper focuses on the unique role geospatial technologies such 
as Geographic Information Systems (GIS), Global Positioning Systems (GPS), and Remote Sensing can play in the 
development and enrichment of geospatial understanding. These technologies serve as teaching tools to develop 
innovative educational approaches and applications to promote spatial literacy, providing skills and knowledge that 
are essential to decision-making, problem solving, and successful academic and professional careers. We propose to 
develop several modules that introduce students and professionals to spatial reasoning while simultaneously serving 
as a data collection and analytical tool. We will present a pilot module on cost-effective and time-efficient close-
range photogrammetry that focuses on, but is not limited to, the discipline on anthropology. This module uses 
experiential learning to facilitate student-oriented learning by integrating theory with practice. 
 
 

INTRODUCTION 
 

In recent years, the use of geospatial technologies has become widespread in many professions; however, the 
teaching of geospatial thinking in academia is still in its formative stages. Given that natural and cultural phenomena 
take place in space, we contend that geospatial thinking, a synthesis of spatial concepts, methods, technologies, and 
applications, must be an essential and integral part of social science education (Burrough and McDonnell 1999; 
Goodchild and Janelle 2004; Hayden 1995; Kwan and Lee 2004). The nature of spatial thinking necessitates hands-
on, experiential learning that allows students to acquire and apply problem-solving skills and analyze relationships 
at different scales and across disciplines. Geospatial technologies such as Geographic Information Systems (GIS), 
Global Positioning Systems (GPS), and Remote Sensing provide tools that facilitate experiential learning, ultimately 
enriching geospatial understanding among students.  

 Researchers and educators have begun to highlight the significant impact television, virtual display, video 
games, and other computer-simulated environments have made on the younger generation, including those attending 
universities and colleges throughout the United States. Studies show that today’s students require innovative 
educational strategies that encourage knowledge acquisition by making use of contemporary development skills, 
heavily grounded in visualization and spatial perception.  Spatial literacy is critical; however, learning materials and 
teaching strategies utilizing traditional lecture-based formats often forgo other more creative strategies that are better 
suited to teach geospatial thinking such as scientific visualization, which offers a more creative approach to facilitate 
learning through visual representations of complex data and spatial relationships (Edelson and Gordin 1997; 
Silverman 2003).  

We believe that close-range photogrammetry, a non-invasive, technique to acquire data from photographs, 
offers a means to introduce students to geospatial technologies and develop spatial thinking. In this paper, we 
present a pilot module that introduces students to the concept of close-range photogrammetry by allowing students 
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to create a 3D computer-simulated model of an archaeological artifact. Such an approach utilizes experiential 
learning, integrating theory with practice and promoting spatial literacy. In general, this classroom module serves 
two objectives 1) introduce students to close-range remote sensing technologies and 2) facilitate the development of 
spatial literacy among students. It is part of a larger effort to promote the use of GeoScience and geospatial 
technologies in order to enrich student learning (Lock 2003; van der Elst et al. 2006; http://www.csiss.org/SPACE/).   
 
 

CULTURAL BACKGROUND 
 

   
                 
 
 
 
 
 

 
 
 
 
 
 
 
            
 
   Figure 1. Archaeological Site of Copan, Honduras 

(adapted from Ferguson and Rohn 1990). 
 

 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
Figure 2. Principal Group at Copan. 
    Insert illustrates West Court 

         (Hohmann  and Vogrin-Hohmann 1982). 
 

Figure 3. Photographs of Altar Q in West Court in 
                       Principal Group, Copan (Richards 2005). 

 
 

The archaeological site of Copan, the largest 
Ancient Maya center in the southeast periphery of 
the Maya lowlands, is located in the Copan 
Valley of Honduras about 14 km east of 
Guatemala (Figure 1). Its main architectural 
complex, the Principal Group (Figure 2), was the 
setting for many regime-organized ritual and 
political acts that served to legitimize and 
reaffirm dynastic power by linking dynastic rulers 
to the past and to the supernatural (Fash 2001; 
Webster 2002). This civic-ceremonial center is 
comprised of monuments and ancestral temples 
that provide archaeological data for many 
interpretations about Copan’s sociopolitical and 
ideological arenas. Altar Q, located in Copan’s 
West Court, which was erected by Copan’s last 
dynastic ruler in AD 775 about a half-century 
prior to the Maya ‘collapse’ offers an interesting 
artifact to carry out a close-range photogrammetry 
project (Figure 3). 
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CLOSE-RANGE PHOTOGRAMMETRY MODULE 
 

Close-range photogrammetry, a remote-sensing technique to acquire data from photographs, can be used to 
record and collect data on archaeological features and artifacts. These data, in turn, can be used to create 3D 
computer-simulated models from which measurements can be derived, mass and volume illustrated, and varying 
visual-spatial perspectives explored.  In this module, photographs of Altar Q will be ingested into PhotoModeler Pro 
5.0, a photogrammetric software package, to demonstrate the process of creating a simplistic 3D model of an 
archaeological artifact.  

The process of digital photo documentation and 3D model development involves three major phases. The first 
involves calibrating the camera and lens. The second phase is to acquire the images, and the third is to digitally 
process them in a photogrammetric software package, in this case, PhotoModeler Pro 5.0. 
 
 

PHASE I: CAMERA CALIBRATION 
 

Camera Diagnostics 
The camera used to acquire the digital images for this project was a Nikon Coolpix 5700 non-metric digital 

camera. A normal lens with a focal length ranging from 8.9-71.2 mm was used; however, a fixed focal length of 8.9 
mm was used to standardize the shots and provide a relatively wide-angle setting without using a wide-angle lens. 
The camera has a resolution of 5.0 megapixels.  
 
Calibration: What is it? Why is it important? 

The calibration of the camera to the PhotoModeler software is necessary to remove the distortions in the images 
that are created by the lens. Removing the distortion has a major advantage in that it permits higher measurement 
accuracy in the 3D model. PhotoModeler requires all photos to maintain fixed settings for three parameters in order 
to use the software for 3D models. These parameters are: (1) same camera, (2) fixed focal length, and (3) standard 
image width (pixels) and image height (pixels). The parameters for this project are: Coolpix 5700 camera with 
normal lens at most-wide angle setting, Fixed focal length 8.9 mm, and Image Height 1704 (pixels) and Image 
Width 2560 (pixels). 

 
 
 
 
 
 
 
 

     
 
 
 
 
 
 
 
 
 
 
 

     Figure 4. AutoCalibation Grid Sheet 
    (PhotoModeler 5.0 User Manual, 2004). 

 
 
 
 

For brevity’s sake, the calibration for this project 
has already been completed. A standard camera 
calibration using the Calibration Grid provided by 
PhotoModeler was used to calibrate the Coolpix camera 
(Figure 4). The final calibration solved all of the 
internal camera parameters and produced a total error of 
0.232 (Filename: FullAutoCalibration_Plotter.pmr). 
This correlates to an accuracy of approximately .23 cm. 
However, the actual accuracy of the final 3D model 
depends on the parameters and precision of marked and 
referenced points in the final project and not only on the 
calibration used for the project. 
 

 
PHASE II: ACQUIRING PHOTOS 

 
Close-range photogrammetry requires multiple photos 
from varying angles to provide sufficient reference 
points and ample coverage of the artifact to be modeled, 
in this case a 8th century stone-carved altar from the 
Ancient Maya site of Copan, Honduras (Figure 5).  
Once the camera calibration is complete, the photos of 
the artifact to be modeled are taken. The higher the 
resolution of the digital images of the object, the higher 
the measurement accuracy of the model; therefore, the 
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camera was set to obtain photos at the highest possible resolution. Each photo required 15.2 MB of storage space. 
       
 
        
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5. Ideal Camera Stations    Figure 6. A 3D Point Derived from Marked Points 
      (PhotoModeler Pro 5.0 User Manual, 2004).      (PhotoModeler Pro 5.0 User Manual, 2004). 
 
Referencing Photos 

Referencing is the process in which points, referring to the same physical point on an object to be measured, are 
marked. These referenced marks are used to create a 3D point (a point with a location in space) for which x, y, z 
coordinates are solved and used to generate the 3D model (Figure 6). Referencing requires that points be marked on 
a reference photo, i.e. the photo to which other photos will be referenced, and then on subsequent destination photos. 
A marked point with the same location must be marked on at least two photos in order to generate a 3D point; 
however, three is ideal. Therefore, it is essential to remember that when taking photographs of an object, a common 
point should be visible in at least three photos. Moreover, these photographs must be taken at approximately 45  
angles relative to one another.  We will refer to referencing later in the module as we mark and reference points.  

 
 

PHASE III: 3D MODEL DEVELOPMENT 
 

Now that a background on camera calibration and photo acquisition has been given, the tutorial will turn to 3D 
model development, on which a greater part of the module focuses. After the camera has been calibrated and the 
digital photographs acquired, phase III begins. This phase is comprised of seven steps. They are as follows: 

1. Setting the approximate project size and measurement units 
2. Describing the camera parameters 
3. Importing initial photograph images 
4. Marking and Referencing points 
5. Processing 
6. Adding new photos, points, lines, surfaces, etc. 
7. Doing measurements or exports 

 
STEP 1. Navigate to the PhotoModeler Pro icon, double-click to open, and to create a New Project click on the 

File tab on the Main Menu. The Project Wizard will open. Choose a Standard PhotoModeler project and click 
Next.  Read the steps in the Project Wizard and click Next. The Project Settings need to be entered. Select the 
appropriate measurement settings based on the object to be measured (e.g. kilometers, meters, centimeters, etc.) in 
this case Altar Q. [Hint: Altar Q dimensions are east-west 152 cm; north-south 147 cm; height 70-72cm; top 132 cm 
(east-west) x 126 cm.]  Calculate approximate size of Altar Q, based on longest diagonal, and enter the information.  
Click Next.  

STEP 2. The Camera Wizard opens. Given that the calibration has already been done, click the option ‘A 
calibrated camera or a camera previously used in PhotoModeler’ and click Next. Browse for the calibration file. It is 
stored in C:\Photogrammetry_Module\FullAutoCalibration_Plotter.pmr and click Next. Carefully review the 
information in the Camera Information Dialog (Figure 7). Remember that the parameters displayed are critical to the 
project’s success (See Calibration section).  Click Next.  
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             Figure 7. Camera Calibration Diagnostics. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

                     Figure 8. Altar Q Project Images. 
 

Navigate to the Referencing menu and select Reference Mode.  A new toolbar is added to the screen. 
 
 

 
 

Marked points (i.e. common points among the photos) will be manually identified and used to link the images. 
Ideally, marked points should be visible on at least three photographs in order to achieve the highest possible 
accuracy. Two points may be acceptable if the photos are already well referenced, i.e. sufficiently linked to one 
another. However, the use of only two points is not recommended as it will most likely reduce accuracy.  

The marking and referencing stage uses a Source Photo and a Destination Photo. Click on the down arrow in 
the left box of the newly added toolbar (Referencing Toolbar) and select Source photo 1. Now, click on the down 
arrow in the right box of Referencing Toolbar and select Destination photo 2 (Figure 9).  

Use the zoom and pan tools                                             to select a common point between the two photographs.  
 
While selecting points try to cover the full extent or visible surface of the object in order to increase the 

project’s accuracy. That is, select at least one marked point near each corner of the object and a few throughout the 
interior to produce the best results. 
 
 
 
 
 
 
 
 

STEP 3. In the Photo Import Wizard, add the 
photographs (digital images) to the project by 
clicking on the Add/Remove Images button. Click 
on the Change Directory button, navigate to 
C:\Photogrammetry_Module\Images folder and 
select an image. All images in the folder will 
automatically be added to the left side of the 
Add/Remove Photographs dialog box.  Select the 
photos required to carry out the project by 
clicking on the photos (hold the shift key to select 
multiple photos) and then click the double-arrow 
button to add selected photos to project.  

There will be a total of eight photographs 
used in the project (Figure 8). Notice that the 
photos selected provide varying angles and 
viewpoints of the altar, which is essential to 
create an accurate 3D model (See Acquiring 
Photos). Click Next.  PhotoModeler confirms that 
these are the images to be used in the project. 
Confirm and click Next. Three of the seven steps 
required to create a 3D model have been 
completed. Click the Finished button to move to 
Step 4.  

STEP 4.  Now that the calibration and photos 
have been added to the project it is time to mark 
and reference points, which is typically the most 
labor intensive, i.e. time consuming, phase of the 
project.  As mentioned above, referencing is 
critical as it allows for the creation of 3D points.  
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Figure 9. Marking and Referencing Points. 

 
Now, select a second destination photo and mark the same point. Remember that to generate a 3D model from 

the photographs requires the same point to marked on at least 2 photos; however, three or more is optimal.  Before 
referencing additional points, Save Project As Altar Q Copan. 

Continue selecting additional marked points using Photo 1 as the source photo. Once a sufficient number of 
points have been selected to adequately cover the visible surface, select Photo 2 as the Source Photo, and then select 
Photo 3, Photo 4, and so on until all photos have been used. For brevity’s sake, select approximately 35-40 reference 
points. Remember to select points that will give shape to the object, e.g. select points along the edges and corners of 
the altar. 

STEP 5. After a sufficient number of points have been selected, the model will be processed.  A processing 
dialog is used to define Camera Stations, i.e. the position of and the direction the camera is facing at the time of 
exposure of a photograph, and orient the photos. Click on the Process                button on the Referencing Toolbar.  
 
 

The Processing dialog box will open (Figure 10). Click on each of the tabs to study the diagnostics of the 
project. In this case, the accuracy potential based on the audit details is High. Click on the Process Tab to run the 
project.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 10. Processing Dialog for Referencing Marked Points. 
 

After the project has finishing processing a Total Error is calculated and a Project Status Report is generated. 
Study the report. What types of errors have been introduced into the project?  

The Project Status Report below indicates that a marking residual in the project is greater than 5.00 (Figure 11). 
A Marking Residual is a residual error, or the difference between where the user marked a point and where the 
program expects the point to be located. The residual is critical as it represents the amount of difference between an 
expected and calculated value. For example, if you expected a certain measurement to come to 3.45mm, but the 
actual final result was 3.41mm then the residual (or residual error) would be 0.04mm.  
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Figure 11. Project Status Report for Processing of Altar Q Copan Project. 
 

In this case Point 33 has a marking residual greater than 5.00. Studying the residual and adjusting Point 33’s 
position on each of the marked photographs can correct the error. Notice that the Total Error is 3.296. This 
correlates to a measurement error of 3.296 cm. Is a ~3.3 cm accuracy sufficient? Explain.  

After studying the project status results, click the ‘Write to text file’ tab.  Remember it is very important to store 
information about any project. The Project Status Report provides valuable data about the project.  

Once all errors have been reviewed and corrected, it is time to view the project in the 3D viewer. Navigate to 
Project on the Main Menu, click on Open a 3D Viewer, and select New 3D Viewer. In the 3D Viewer Option dialog 
check the boxes for Points, Point ID’s, and Lines (Figure 12). Click OK. At this phase, the project is comprised only 
of the points that have been marked on the photos. Now, lines and surfaces will be added to the 3D model.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 12. 3D Viewer Option Dialog Box. 
 

STEP 6. Close the 3D Viewer and navigate to the Marking tab on the Main Toolbar.  Select the Mark Lines 
Mode tool, which will mark lines on the project. In this case, we will mark the edges of Altar Q in order to delineate 
the altar’s shape. Click on a referenced point using the Mark Lines tool, move to the next appropriate point and click 
on it to create a line. Continue this process until an outline of the altar has been generated. Open a New 3D Viewer. 
Uncheck the Point ID’s and Click OK (Figure 13).  

Status Report  
Project Name: Altar Q Copan.pmr 
 

Problems and Suggestions (1) 
   Project Problems (1) 
      Problem: The largest point residual in your project (Point33 - 6.08) is greater than 5.00. 
         Suggestion: In normal projects, strive to get all point residuals under 5.00 pixels. If you have just a 
few high residual points, study them on each photo to ensure they are marked and referenced correctly. If 
many of your points have high residuals then make sure the camera stations are solving correctly and that 
your are using the best camera parameters possible. 
Information from most recent processing 
   Last Processing Attempt: Sun Jan 29 10:08:35 2006 
   PhotoModeler Version: 5.2.3 
   Status: successful 
  

   Total Error 
      Number of Processing Iterations: 4 
      Number of Processing Stages: 2 
      First Error: 3.261 
      Last Error: 3.296 
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               Figure 13. 3D Model of Altar Q illustrating Points and Lines. 
 

After selecting the Path Mode tool, maximize the 3D Viewer. Click on the Options tab and check Surfaces. In 
the surfaces box, choose Shaded. Texture will be added later. Click OK. Given that each side of Altar Q is a 
rectangle, each surface will be comprised of four lines. Click on the four lines that comprise a side—they will be 
highlighted in red as they are selected. Remember the lines must be clicked consecutively as the Path Tool is being 
used. Continue creating surfaces until a box-like shaded shape has been created (Figure 14).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figure 14. Surface Creation Using Shaded Option. 

 
 

Now click on the Options tab to open the 3D Viewer Options dialog. In the Surfaces box, click the dropdown 
arrow and select Quality textures. This will overlay the Altar with the original photos used in the project (Figure 15). 
 
 
 
 
 
 
 
 
 
 
 

An outline of Altar Q has been created. 
To add mass to the altar, surfaces will be 
generated. Minimize the 3D Viewer and 
navigate to the Marking tab on the Main 
Toolbar, click on Surface in the dropdown 
list, and click on Path Mode. The Path Mode 
option constructs a surface using a closed 
loop of 3D objects such as points, lines, 
edges, and curves. The loop becomes the 
outer boundary of the surface and the interior 
is interpolated. Interpolation is key concept 
in many types of spatial analysis. Spatial 
interpolation is the process of calculating 
unknown values from a set of sample points 
with known values that are distributed across 
an area (ESRI Virtual Course).  
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Figure 15. 3D Model of Altar Q with Textured Surface. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

              Figure 16. Setting 3D Scale and Rotation for Altar Q. 
 
 

STEP 7. We now have a 3D computer-simulated 
model of Altar Q; however, before the model can be 
used to take measurements, the 3D Scale and Rotation 
must be set. Scale is achieved by adding a known 
distance between two points in the model.  Rotation 
uses control points or axes constraints to orient the 
model.  

Navigate to the Project tab on the Main Menu and 
select Scale/Rotate. The 3D Scale and Rotation dialog 
box opens. Click on the Scale tab, select cm, type 152 
in Distance box, and click on a horizontal line (e.g. 
red line) on the altar. Click Define. 

Now click on the Rotate tab. Define the 3 
parameters by selecting the appropriate lines for each 
required category (Figure 16). Click OK.  

Open a new 3D Viewer. Click on the Measure 
tool. Click on several of the lines to study the 
accuracy of the measurements for the various faces of 
Altar Q. Click on a surface. Notice that the 
measurement tool automatically calculates surface 
area (Figure 17). The software utilizes the camera 
calibration information along with photogrammetric 
algorithms to compute distance and measurements in 
the photos to build the 3D model. 

Play around with the 3D model. Rotate the model 
on its axis. Take several measurements. How do these 
measurements compare to those provided above for 
Altar Q (See STEP 1)?  Given this level of accuracy, 
what types of questions can be addressed? Do you 
find the computer-simulated 3D model useful? If so, 
how is it useful? Does it allow you to answer 
questions that could not be answered using a 2D 
image or drawing?  
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Figure 17. Using Measurement Tool in PhotoModeler. 
 
Synopsis   

Now to review the phases and steps involved in creating a 3D computer-simulated model using close-range 
photogrammetry. Phases I and II were done in a previous lab/field project. Phase III involved seven steps. First, the 
project size and measurement units were entered. Second, the camera calibration characteristics were entered into 
the PhotoModeler software program. Third, the photographs, or digital images, taken in the field were downloaded 
and imported into the software.  Fourth, common points among the photographs were marked and referenced. Fifth, 
the images were oriented and processed to generate a virtual 3D model comprised solely of points. Sixth, lines and 
surfaces were added to the model to give it mass, volume, and texture. Seventh, measurements of length, width, 
height, and surface area were calculated.  
 
 

CONCLUSIONS 
 

This paper sets forth a close-range photogrammetry module as a means to exemplify the utility of hands-on 
experiential learning in developing spatial literacy among students. It provides a step-by-step guide to camera 
calibration, photo acquisition, and 3D model development using the principles of photogrammetry. It is our goal to 
develop additional modules centered on geospatial methods and analysis taking advantage of recent advances in 
geospatial technologies such as Geographic Information Systems (GIS) and Global Positioning Systems (GPS). We 
believe that spatial thinking is essential to solve many of today’s scientific and social issues and thus, it is necessary 
to develop innovative and creative learning materials and teaching strategies that integrate geospatial perspectives in 
education, especially the social sciences. 

The module itself fits within the broader framework of Computer Assisted Learning (CAL), which offers many 
advantages to traditional learning. These include: 1) computer-simulation allowing for dynamic, interactive 
interfaces, 2) virtual collections providing access to often restricted or unavailable objects, and 3) online modules 
that reach a wider audience (Lock 2003). This module, along with other modules focused on spatial learning, can be 
seen to complement classroom discussion on geospatial theory, methods, and applications and with further 
enhancement may be utilized for professional development and skill acquisition, especially in regions with limited 
access to skilled educators (e.g. developing countries).  
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